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•

Ultra Low Latency Software Mixer

•

Advanced Monitor Control

•

Scrollcontrol

•

True Phantom Power over USB

•

USB3.0 Bus Powered

•

All Metal Design

•

Free Software + Plugins

Inside the box:
•

iD14

•

USB-C to USB-C cable

•

Quick Start Guide

iD14 Overview				
Safety Information			
Declaration of Conformities
					

5

Hardware
Features:
			

Microphone & Line Input		
Instrument Input
Headphone Output
Digital Inputs		
Loudspeaker Outputs		
Monitor Control			
Metering
Kensington Lock

37

38
Pro Tools Setup
39
Logic Pro Setup		
41
Cubase/Nuendo Setup		
42
Ableton Setup

7
8

9
Mac Installation			
11
Windows Installation		
iD App & Firmware Update		 13
		

iD Mixer Application:
		
Input Channel Types
Channel Features
Mastering Section Features
System Panel Features
Setting Up & Using Talkback
Save & Load Mixer Presets
Menu/Task Bar Icon
Audio Loop-back
Keyboard Shortcuts

2

Daw Setups

4

Troubleshooting & FAQ
Technical Specifications
Dimensions
Warranty & Contact
Service
Glossary

14
15
16
16
17
18
18
19
19

20
21
23
24
27
30
31
32
34
36

3

43
46
47
48
49
50

iD14 Overview

Safety Information

Channel 2 (Mic/Line Input)
Main Meters

Important Safety Instructions
Please read all of these instructions and save them for later reference before connecting
the USB and powering up iD14.
The iD14 itself does not operate with any high voltage mains supply inside the unit but appropriate
safety measures should still be adhered to regarding the USB supply.

Volume
Knob

Channel 1
(Mic/Line Input)
Phantom
Power

Headphone
Output Select

audient.com/support
Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the
power supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the appropriate
international pin adapter is fitted to the power supply before insertion into the mains socket.

iD Button
Main Output Select

USB-C
Connection
ADAT Optical
Input

2 x Speaker
Outputs

WARNING!

Mic/Line
Inputs 1 + 2

To reduce risk of fire or electrical shock,
DO NOT expose this apparatus to rain
or moisture.
No user serviceable parts inside.
Please refer servicing to qualified
service personnel.

Instrument Input

Dual Headphone Outputs
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Safety Information

Declaration of Conformities

Important Safety Instructions

FCC Part 15B

1. Read these instructions

This apparatus has been tested and found to comply with the limits of a class-A digital device,

2. Keep these instructions

pursuant to Part 15B of the FCC Rules. These limits are designed to provide reasonable protection

3. Heed all warnings

against harmful interference in a residential installation. This equipment generates, uses and can

4. Follow all instructions

radiate radio frequency energy and, if not installed and used in accordance with the instructions,

5. Do not use this equipment near water

may cause harmful interference to radio communications. If this equipment does cause harmful

6. Clean only with dry cloth

interference to radio or television reception, which can be determined by turning the equipment

7. Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment

off and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

(including amplifiers) that produce heat
8. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized
plug has two blades with one wider than the other. A grounding type plug has two blades

1.

Re-orient or relocate the receiving antenna

and a third grounding prong. The wide blade or the third prong are provided for your safety.

2.

Increase the separation between the equipment and receiver

If the provided plug does not fit into your outlet, consult an electrician for replacement of the

3.

Connect the equipment into an outlet on a different circuit from that

		

obsolete outlet
9. Protect power cords from being walked on or pinched particularly at plugs, convenience

4.

to which the receiver is connected
Consult the dealer or an experienced radio/TV technician for help

receptacles, and the point where they exit from the equipment
10. Only use attachments/accessories specified by the manufacturer
11. Unplug this equipment during lightning storms or when unused for long periods of time
12. Refer all servicing to qualified service personnel. Servicing is required when the equipment
has been damaged in any way, such as power supply cord or plug is damaged, liquid has
been spilled or objects have fallen into the equipment, the equipment has been exposed to
rain or moisture, does not operate normally, or has been dropped
13. For products that are a mains powered device: The equipment shall not be exposed to dripping
or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment

		
		
		

We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK,
01256 381944, declare under our sole responsibility that the product iD14
complies with Part 15 of FCC Rules.

		

Operation is subject to the following two conditions:

		
1.
		
2.
			

This device may not cause harmful interference,
This device must accept any interference received,
including interference that may cause undesired operation

We, Audient Ltd, declare that the product, the iD14, to which this declaration
relates, is in material conformity with the appropriate CE standards and
directives for an audio product designed for consumer use.

Audient Ltd has conformed where applicable, to the European Union’s
Directive 2002/95/EC on Restrictions of Hazardous Substances (RoHS) as
well as the following sections of California law which refer to RoHS, namely
sections 25214.10, 25214.10.2, and 58012, Health and Safety Code; Section
42475.2, Public Resources
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Mac Installation

Installation

System Requirements
macOS 10.11.6 (El Capitan) or later
Mac: Intel or Apple Silicon CPU,
1GB RAM Minimum

1. Download the latest iD
Software
USB - C

Head to our website for the latest version of
our iD Mixer:

audient.com/products/downloads/
iD14
Drag

the

downloaded

app

into

your

application folder to install it.

2. Connect iD14
Using the USB cable provided, connect
iD14 to your computer’s USB port.
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Mac Installation

Windows Installation

3. Status LED

Windows System Requirements:

Once connected to your computer and

•

Windows 7 or later (32 or 64 bit)

powered on, the white USB LED on iD14 will

•

Intel Core 2 @ 1.6 GHz, or AMD 		
equivalent

illuminate.
•

1 GB RAM Minimum

1. Download the iD14 Software
Head to our website for the latest version of
our iD Windows Installer:
If at any time the status LED turns off during
normal operation please check all connections

5. Open the iD Mixer

and if further problems develop please

audient.com/products/downloads/
iD14

contact Audient support.
Run the iD software. It will appear as an icon

4. Double Checking Connectivity

in the Menu bar of MacOS. Click on this and
select “Open Mixer Software”.

To ensure iD14 has been detected by your

2. Connect iD14
Using the USB cable provided, connect
iD14 to your computer’s USB port.

computer and correct clocking sources are
set-up, navigate to:

3. Run iD Mixer Setup

Macintosh HD > Applications >

Double click on the installer to run the iD mixer

System Preferences

setup and follow the onscreen instructions.

Check that iD14 is set as your i/o device.
It’s recommended to disable system sounds.

4. Reboot PC
Reboot your PC to make sure that all the
drivers have been applied.
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Windows Installation

Mixer App & Firmware Update

4. Check Connectivity

Launch the iD Mixer Application

Firmware Update

Launch the iD14 mixer application

When there is a firmware update, you can

by finding it in the following folder:

select ‘From audient.com’ to download the
latest version automatically (or select ‘From

Macintosh HD > Applications > iD

file’ to install a local firmware file).

Start > All Programs > Audient > iD
The USB status LED will illuminate as soon as

For more information on the mixer

iD14 has achieved stable communication and

application feature set, please refer to

should remain solidly lit during operation of

page 21 of this manual onwards.

the unit until power down.
For mixing, buffer size of 256 should be perfect.
To double check the connection, go to PC

For tracking, experiment with lower buffer

sound settings by following:

size values. How powerful your computer is,
and how processor hungry your project is,

PC Settings > Control Panel > Hardware and

will affect how low you can get the buffer size

Sound > Sound

settings before you get audio instability.
The latest version number will be retrieved

Here you can see whether iD14 is visible to

from our servers and will be displayed (as

the PC and you can make it the computers

shown above). Press next to continue with the

default sound device by pressing ‘Set Default’.

firmware update. Press ‘update’ to
install it.

Check for Firmware Updates

iD Icon

If your computer is connected to the internet,
Once installed, the iD icon can be found in the

the iD app will check for firmware updates

Windows system tray (it may be in the hidden

whenever a unit is connected. If there is a

icons area):

firmware update available then the iD app
will notify you.

•
•

Double-click to open iD14 mixer window
when iD14 is connected

You can manually check for updates by

Right-click to quit or change sample rate

going to the Help menu and selecting ‘Check

and buffer size.

for Updates’. It will notify you if you’re on the
latest version of firmware.
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Hardware Features

Microphone Preamplifiers
& Line Inputs
iD14 features two classic Audient Console
microphone preamplifiers. These preamps
are based on designs from Audient’s classic
consoles and are the same that are used
across our entire ‘iD interface range’.
The design features discrete Class-A circuitry
providing exceedingly low distortion and
noise performance. From a sonic point of
view, iD14 is fast, open and detailed.

The microphone preamplifiers feature:

Amphenol™ XLR/TRS Jack combi-connectors
provide microphone and line inputs. The line
inputs are padded through the microphone

•

58 dB of clean gain

•

48v (±4V) phantom power rated at
10mA/channel

preamplfiiers.

•

> 2.8kΩ input impedance which
provides a punchy tone from any
microphone transducer type

Extra features such as a +10dB boost
and polarity reverse can be accessed
via the iD App (See page 23).
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Instrument Input

Headphone Output

Digital Inputs

Speaker Outputs

iD14 employs a discrete class-a JFET

iD14 features an independent high-current

iD14 features an optical input connection.

iD14 has two pairs of stereo speaker outputs

instrument (D.I) input on channel one which is

headphone amplifier. This can be accessed

This can be set to operate as stereo optical

on the back panel in the form of balanced TRS

easily accessible on the front of the unit.

using both the 3.5mm and 6.35mm sockets

S/PDIF or 8-channel ADAT (SMUX) via the

jack connectors. The outputs are impedance

found on the front of the unit. The same

System Panel in the iD mixer application. Both

balanced using the same topology as our

The JFET circuitry adds a tiny bit of colour and

audio signal comes out of both connectors

formats will operate at up to 96kHz sample

flagship console, the ASP8024.

distortion to the signal, making it sound great

simultaneously, so it does not matter which

rate.

on guitars and basses.

you plug your headphones into. You can also

The outputs are fed from high quality DACs

plug in two pairs at the same time.

(Digital to Analogue Convertors) sending

Plugging in a TS (tip-sleeve unbalanced)

clean, linear audio to your speakers, perfect

jack will override the mic signal and turn

for critical listening.

channel one into a fully fledged, fantastic
sounding instrument input with access to the
polarity reverse (useful for phase alignment
between a mic and D.I) and the +10dB boost
Running in S/PDIF mode allows 2 channels of

for quiet inputs.

audio up to 96KHz.
The headphone output can comfortably drive
a wide range of headphone impedances

Running in ADAT mode, the optical input

meaning that you will get great sounding

provides a great way to expand to 10 inputs

audio no matter what model of headphones

for recording via an external mic preamp such

You can use these outputs for more than just

you have.

as an Audient ASP800. When using 88.2kHz

speakers. A good example of this is if you

and 96kHz as a sample rate, you only have

want to use a dedicated headphone amplifier

access to 4 channels of digital input (due to

for multiple musicians, you can connect this

the way ADAT works at higher sample rates).

up to one or more of these outputs, This is
configured in the iD mixer software.

For more information about system clocking
please refer to pages 28 onwards.
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Monitor Control
iD14

provides

excellent

monitor control

functionality using the large aluminium
encoder and the encoder buttons.
As such, it is possible to control main

Hardware Metering

Kensington Lock

The 8-segment hardware meters indicate

For those who work in educational

playback level of the iD mixer app, so it is

establishments or in situations where your

suggested that end users observe their DAW

equipment is public facing and subject

metering for input levels.

to possible theft opportunities, we have
provideda Kensington lock hole to enable you

loudspeaker and headphone volumes with a

to protect your iD14.

perfectly matched stereo volume control
on the main unit.

iD Button

The three encoder mode buttons allow you
to change what the encoder controls. The
button that is selected will be illuminated.

The iD button provides extra functionality in
the form of an assignable function button, or
it can be used to activate iD14’s ScrollControl
which turns the encoder into a virtual scroll

Loudspeaker and Headphone
Buttons

wheel allowing you to control compatible
parameters within your DAW or plugins.

Pressing the speaker or headphone button

Status LED
The status LED indicates connection via
USB to your computer. A solidly lit light means
that there is stable communication between
iD14 and your computer.

When the iD button is set as a function button,

allows the encoder to control the level of the

the encoder will continue to control the output

selected output. The volume of the output is

that was previously selected. The iD button is

displayed on the meter LEDs and a press of

assigned in the iD app.

the encoder will mute the output.
When a selected output is muted, the
corresponding encoder button will flash,
repeatedly until unmuted.
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iD Mixer App

Input Channels - Channel Types
The iD mixer application features three types

Using these three channel types, you can

of input channels:

build up your main monitor mix and up to
two additional cue mixes.

• Mic Inputs
These are the inputs where you will see

Its important to note that the iD mixer

the signal from the iD14’s two analogue

application only controls the monitoring

inputs.

of the iD14. Changes made to the iD mixer
application won’t affect the level present in

• Digital Inputs

your DAW or audio software.

These are the inputs from the iD’s optical
inputs. The number of digital inputs
present on the iD mixer application
depends on the digital input type (S/
PDIF or ADAT) and the sample rate being
used.

• Daw Returns
These are the signals being played back
from your DAW. The iD14 has 6 Daw
Return Channels allowing you set up
multiple cue mixes or sends to hardware
outboard gear.
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Channel Features

Channel
Name
Phase Flip

Pan Control

Channel Name

Solo

By double clicking on the name of the channel

The Solo button mutes all other channels

you can rename it to help you organise your iD

other than the one that is currently solo’d.

mixer application. You could name a channel

Multiple channels can be solo’d at one time.

‘Kick’ or ‘Snare’ for example.

Mute

Phase Flip

The Mute button stops this channel from
outputting audio whilst it is engaged.

Inverts the polarity of the signal by 180° to
stop phase cancellation. This is useful if you

Stereo
Grouping
Mute

Solo

are micing the rear of a guitar amplifier or the

Fader

underside of a snare drum.

The fader controls the amount of signal that is
sent to currently selected mix. This can be set

Pan Control

to anywhere between -inf dB to +6dB.

Allows you to send the audio to the left, to
the right or anywhere between on your Main

Meter

Monitor Mix or Cue Mixes.

The meter shows the current signal level in
dBFS. Should the signal level exceed 0dBFS

Stereo Grouping

then the peak indicators will illuminate red to

Allows you to group two ajacent channels

indicate a peak. The peak indicators can be

together into a stereo channel with a single

turned off by clicking in them. You can also

fader controlling the level of both channels.

turn off all peak indicators using Alt + Click.

When a channel is stereo grouped, the pans
will automatically be set to far left and far

Meters

right.

+10dB Boost
Fader

Selecting this will boost the incoming signal
by +10dB for recording quiet sources. This will
also affect the audio being fed into your DAW.
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Master Section Features

Mix Solo

Mix Selection

Channel Views

Clicking on one of mixes allows you to make

These three buttons allow you control which

changes to that mix. When a mix is selected, it

of the three channel types are shown in the

expands to reveal additional controls for that

mixer. If for example you weren’t using the

mix.

digital inputs for a particular project, you can
simply hide the optical channels by clicking

Cue Mix Name

Mix Selection

on the OPT control.

Double clicking on a Cue Mixes name allows

Channel Views

you to rename the Cue Mix. If for example you
were creating mixes for four separate band
members, you could name them ‘Drummer’,
‘Guitarist’, ‘Bassist’... etc.

Cue Mix Name

Mix Solo
The Solo button allows you to audition each
of the Cue mixes through your monitors.

Cue Mix Level

Mix level

Mix Meters
Chronometer

The Mix level allows you to control the overall
level of the Cue mix that is sent to the outputs.

Mix Meters
The Mix meters show the master signal level
of the selected mix.

Chronometer
Monitor Controls

The Chronometer allows you to see not only
the current signal level but also the signal
level from a few seconds previously.
This can be great to track down a sudden
loud transient on a particular cue mix or to
monitor the change in level over time as you
make changes to a mix.
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• Dim

Monitor Controls
These six buttons control various aspects of

Reduces the output level by a preset

the iD14’s monitor controller capability. The

amount which can be great if you get a

function of each control can be found below:

call or need to quickly chat to someone
during a session.

• TB (Talkback)

System Panel Features

Digital Input
Format

Output
Routing
Selection

Clock Source
Selection

The talkback button switches talkback
on and off. More information regarding

Mono Mode

talkback and its various settings can be

Routing
Matrix

found in the ‘System Panel’ section of this
manual.

Monitor and Headphone Mute

• ø (Phase Flip)
Pressing this switch flips the phase of

This allows you to mute either the monitor

one side of the stereo field. Used in

outputs or the Headphone outputs from the

conjunction with the mono button, this

Dim Level
Alt Speaker
Level

software. A cross will show through the icon

can be a great way to remove centred

to indicate that an output is muted.

elements from a mix in order to hear the
hidden elements of a mix.

Input
Source

Talkback
Source

• Mono
The mono button sums the stereo outputs
down to mono. This can be used to
quickly check the mono compatibility of
your mix to make sure it’ll sound great
almost anywhere!

• Alt
Alt allows you to quickly switch your
monitor path to a secondary set of
monitors to let you check how your mix
translates on various speakers.
You can select which outputs the ‘ALT’
monitor control flips to in the System

Talkback
Device

Panel.
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Digital Input Format

Mono Mode

Routing Matrix

Allows you to select whether the optical input

When the iD14’s Mono feature is engaged

The Routing Matrix allows you to control the

DAW THRU - This allows you to route to

uses ADAT or S/PDIF digital format.

this option controls whether the mono signal

audio source for each of the iD14’s outputs

outputs exactly as they would appear

is sent to the left, right or both monitors.

from the following options:

in your DAW. For example, if you set

Prefered Clock Source

Dim Level

Analogue out 1+2 to DAW THRU, anything
•

The Clock source can be selected from either
the internal clock or the optical input. More

When the iD14’s dim function is engaged,

information about choosing a clock source

this control defines how much the level is

can be found in the clocking section of this

reduced by.

manual.

Main Mix - This takes signal from the

your DAW sends out to Outputs 1+2 will be

Master Mix of the iD mixer. This is what is

sent directly to Analogue outputs 1+2.

usually used for most standard playback.
Please note that in DAW THRU, the
•

Alt Speaker Level

Alt - This takes signal from the Master

channel in question will bypass any

Mix but only when the Alt speaker mode.

volume control and audio will be passed

is active.

at full scale. If this output is sent to a set
of monitors without inline attenuation, this

When using an external clock source the

may be very loud.

indicator beside the selector shows the

This control defines the level drop/boost

current status of the clock on that input.

when the iD14 is switched to ALT speaker

two cue mixes which can be created

mode. This is used to balance levels between

using the iD mixer. Please note that the

The only exception to this is the

different speaker brands.

hardware volume control does not affect

headphone outputs where the volume

these mixes and the Cue’s have separate

control will still function.

•

Red - No clock signal detected on input

•

Amber - A clock signal is detected but at a

Output Routing Selection

different sample rate to iD14
•

Green - A clock signal is detected

•

Cue A & B - This takes signal from the

trims which can be adjusted when the
cue mix is selected in the Main Mixer

Opens the routing matrix for either the

and is at the correct sample rate.

Window.

Analogue Outputs, Digital Output 1 or the
For an external clock source to be working

Talkback channel.

correctly you would want the indicator to

iD Mode

be green. If the indicator isn’t green, iD14
will default back to the internal clock until it

Controls wheter the iD button engaged Scroll

detects a valid clock input.

Control or one of the Monitoring functions.
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Talkback Source

Saving & Loading Mixer Presets

The Talkback source allows the talkback input

To allow you to quickly setup your iD mixer

Simply enter the name of your preset and

to be taken from one of the iD14’s internal

during a session you can save and quickly

press save.

inputs or from a device connected to the host

load various presets. This is great if you are

computer (such as a built-in microphone or

moving between recording scenarios quite

It is also possible to export your preset files

USB microphone).

often.

in order to send them to friends or to simply
save them within your DAW session files for

When you select an input as your Talkback

Mixer presets can be saved and loaded in

easy recall later on. To do this, select Export

channel, the channel for this channel in the iD

two ways:

Mixer Configuration at the base of the Save

mixer will be changed to a talkback channel

screen.

which will have a TB button in the centre.

•

Using the File menu and selecting either
Save or Open.

Loading a Mixer Configuration

Using standard keyboard shortcuts :

To load a previously saved preset, select

If using an external device, the talkback signal
will appear on channel DAW 6.

•

File > Open to bring up the Load screen.
Faders will only appear for these channels on

Save: Mac -

the Cue mixes, not on the Main Mix.

Windows Load: Mac -

Talkback Device

Windows -

If an external device is selected then this allows
you to select which connected device is used.

Cmd + S
Ctrl + S
Cmd+ O
Ctrl + O

Saving a Preset
To save a preset, simply setup your mixer the
way that you’d like to save. Then select File >

The previosuly saved configuration will

Save as explained above. The mixer window

appear in a list. Select the configration you

should then show the Save dialog.

wish to use and click Load.
You can also open a mixer configuration
directly from a file by selecting Load From File.
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Menu/Task Bar Icons

Check for Updates

Firmware Update

MacOS

The iD app will check with the Audient

Occasionally, Audient will release a firmware

update server for any available firmware

update for the iD14 in order to address

updates for iD14.

bugs, improve compatibility and add new

On MacOS, the iD icon appears in the
menu bar in the top right hand corner of the

Windows

screen. This gives you quick access to various

features. Therefore you may wish to check
occasionally for any updates.

functions of the iD14.
The Windows taskbar Icon has all the options

This can be done by navigating to the Window

of the MacOS menu bar icon but also

menu and selecting Check for Updates.

includes some Windows Specific options.
The iD mixer application will then check with
our update server if any updates for the iD14
are currently available. If there are then you
will prompted to install them onto the iD14.

Quit
Fully closes the iD mixer application.

Set Sample Rate

About iD

Sets the operating sample rate of iD14. 44.1,

Displays information regarding the current

48, 88.2 and 96kHZ are the four options

version of the iD mixer application.

available.

Visit iD Knowledge Base

Set ASIO Buffer Size

If you then click next, you’ll be prompted to
stop any playback through the iD14. Click
Update and the update will begin. The iD14

Opens a browser window for the Audient

Sets the buffer size of the iD14 between 16

Helpdesk with helpful articles and FAQ’s.

may turn off a number of times.

and 4096 samples. Higher sizes will take
processing load off your computer but will

Set Clock Source

cause increased latency.

Allows you to quickly adjust the clock source
between the internal and optical clocks
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Audio Loop-back
Using the Loop-back Mix

As part of the software mixer of iD14, you also
have the ability to loop-back audio so you

MacOS

Windows

To adjust your output channels, you’ll need to

On Windows you can simply change your

can record or stream audio from different

To record or stream your loop-back mix,

go to the Audio MIDI setup utility. This can be

output channel by going to the ‘Sound’

applications on your computer. To give you

simply select either Input 11+12 (Inputs 3-10

found by going to:

settings found in the ‘Control Panel’. Go to the

additional flexibility the iD Mixer gives a

are preserved for the additional ADAT inputs)

number of sources for your loop-back audio

or Loop-back 1+2 in your audio software.

Finder > Applications > Utilities > Audio

which can be adjusted in the iD menu:

The input name you will see is dependent

MIDI Setup

‘Playback’ device list and select ‘Output 3+4’
or ‘Output 5+6’ as your Output Device.

on your DAW or audio software.
You should now see a list of audio devices
currently connected to the Mac. Select
the iD14, go to the ‘Output’ panel and click
“Configure Speakers”. Now set the Outputs to
Loop-back 1 and Loop-back 2.

The sources are as follows:
DAW 1+2 - Any audio being sent to outputs 1+2
of the iD14

Sending Audio to the Loop-back
Outputs

DAW 3+4 - Any audio being sent to outputs
3+4 of the iD14

Most DAW’s and audio software will allow
DAW 5+6 - Any audio being sent to outputs

you to select your audio output as part of the

5+6 of the iD14

audio preferences or in a mixer. Again, for

Master Mix - The audio mix created in the iD

details on how to do this, check the manual

Click ‘Apply’ and all audio on your computer

or documentation for your software.

will now be sent to these channels in the iD
Mixer allowing you to set up a loop-back mix

mixer on the Main Mix panel
However, for applications that don’t give you

that is separate to your Main Output, which

Cue A - The audio mix created in the iD mixer

this option you can simply adjust the system

you would continue to use for monitoring.

on the CUE A panel

settings.

Cue B - The audio mix created in the iD mixer
on the CUE B panel
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Keyboard Shortcuts

DAW Setup

Keyboard Shortcut Index
To allow you to find all shortcuts for the mixer
application in one place without having to
go through each page of this manual please
refer to this table:

Location		Mac			Windows		Description
		
Faders		

Alt + Click		

Alt + Click		

Resets fader to unity gain (0 dB)

Pans			

Alt + Click		

Alt + Click		

Resets pan pots to central

									position
Solos			

Cmd + Click		

Ctrl + Click		

Clears all solos if clicking on a solo’d

									channel
									Overrides all other solos (for solo
									exclusive) if clicking on an unsolo’d
									channel
Meters		

Alt + Click		

Alt + Click		

Clicking on peak hold indicator will

									clear all clip indicators
System Panel

Cmd + S		

Ctrl + S		

Save mixer configuration

			

Cmd + O		

Ctrl + 0		

Load mixer configuration

View Modes		

Cmd + 1		

Ctrl + 1			

View Mic/Line Input

			

Cmd + 2		

Ctrl + 2		

View Optical (Digital) Inputs

			

Cmd + 3		

Ctrl + 3		

View DAW Mix Inputs

			

Cmd + 4		

Ctrl + 4		

View System Panel

Please check the iD14 page online at audient.com/products/iD14
for the latest mixer application updates.
More shortcuts may be added without notification.
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Logic Pro Setup

Pro Tools Setup
Operation with Pro Tools

Operation with Logic Pro

If you are using the iD mixer to monitor input
signals while recording, be sure to disable

If using Windows, ensure that you have

Once iD14 has been successfully installed

Logic’s software monitoring to avoid phasing

followed the installation instructions found on

following the steps detailed after page 11 of

as the same source will be heard twice with

page 11.

this manual, launch Logic Pro and check the

a short delay between the low latency DSP

following:

signal and the delayed software monitoring
signal.

With iD14 connected, launch Pro Tools and
Logic Pro > Preferences > Audio

ensure that a new session is created at

Assigning I/O

the desired sample rate. If you are using
Windows, make sure that you have already
set your Latency and Buffer Size settings in

Go to Setup > I/O... to label your inputs and

All of iD14’s input and output channels will

the iD System Tray before opening a project.

outputs and ensure that iD14 is correctly

be available to Logic for routing. There are

Changing these mid session will result in Pro

reporting 10-inputs and 6-outputs to and

a total of 10-inputs and 6-outputs reported

Tools needing to restart.

from Pro Tools.

from the driver. You can rename input and
output channels to whatever you wish using
the I/O label function. This is a great way to
keep things organised.

Ensure that iD14 is selected as the active
audio device and set the buffer size (to affect
system latency). If you are experiencing issues
with playback stability and CPU loading, try
increasing the buffer size. This appears with
“overload” errors and/or pops and clicks and
distortion in the audio.
For more Pro Tools information consult your

Playback Engine

Mix > I/O Labels

Avid user manuals & documentation.

Go to Setup > Playback Engine... and ensure
that iD14 is set as the active playback
device.
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Cubase/Nuendo Setup
Operation with Logic Pro

Macintosh HD > Applications > Utilities

Operation with Cubase / Nuendo

Then select the Audient iD14 from the
dropdown menu. You will be asked if this is

If you are using an external clock source

If using Windows, ensure that you have

(ADAT or S/PDIF) to clock iD14, please ensure

followed the installation instructions found

that your Logic Pro project is set to the same

on page 11. With the iD14 plugged into your

sample rate when recording and playingback

computer, Launch Cubase or Nuendo and

in a session, otherwise things may sound a bit

once a session is open, go to:

okay, select “Switch”.

sharp or flat!
Studio > Studio Setup...
File > Project Settings > Audio
Close the VST device setup panel and navigate
to the Audio connections panel:
Devices > Audio Connections (F4)
Here you can ensure that all buses have been
created in Cubase / Nuendo and therefore
all ports are addressable in your session. Add
new buses and assign them to the necessary
I/O if required.

If you are using the internal clock in iD14,

Select VST Audio System from the list of options

setting the sample rate via Logic Pro will
update the iD14 sample rate to follow your
session.

If using the iD14 Mixer App to monitor your
There may be a slight pause as the system

inputs, ensure that input monitoring is turned

re-clocks. This is normal.

off on the track.
For more Logic Pro information please

This can be verified in Audio MIDI Setup.

consult your Apple user manuals &
documentation.
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Ableton Live Setup
Operation with Ableton Live
If necessary you can limit the number of i/o
If using Windows, ensure that you have

channels reported as active inputs (from the

followed the installation instructions found on

driver) in Live by using the input and output

page 11.

config tabs. This is an excellent feature to
help reduce CPU loading if all channels are
not required.

With iD14 plugged into your computer, launch
Ableton Live and head straight to:
Live > Preferences > Audio

Troubleshooting & FAQ
Troubleshooting

Double check that iD14 is set as the active
playback device in your DAW and computer:

“The unit will not power on”
System

Preferences

>

Output Tab > Audient iD14

Double check that the USB cable is plugged

Sound

>

(macOS)

in. If it still won’t power on, try using a different
USB port on the computer and possibly even

Control Panel > Hardware and Sound >

a different USB cable. If you are using a USB

Sound > Manage Audio Devices > Audient

hub, please try plugging iD14 directly into the

iD14 (Windows)

computer.
Launch the iD mixer application to activate
communication

“I get clicks and pops on DAW
playback”

between

your computer

and iD14. This only needs to be done once
straight after power up. Once iD14 is set to the

This is most likely to do with setting the

operational state you desire, you can quit the

buffer size too low for your computer. This

iD application and it will continue to function

can be caused by running very large projects

as intended.

with a lot of plugins and virtual instruments.
Experiment with higher buffer sizes. Typically

In the software mixer, locate the DAW

Here navigate to the Audio tab and make sure

you want small buffer sizes for tracking or

channels by pressing the DAW view button

that iD14 is assigned as the playback device.

recording software synths to keep the latency

and increase the level of DAW 1+2 fader.

low. However when mixing it is fine to set a
slightly higher buffer size as latency is not so
much of a problem.

“When I connect to my computer,
I cannot play any audio out from iD14”
Firstly double check that the USB cable

In the Live Audio Preference panel you can

connecting iD14 to your computer is

set an appropriate buffer size (this can be

functional and attached at both ends.

kept high if you are monitoring input signals
for recording via the iD mixer. Ensure that
iD14 reports as a 10-in, 4-out device to Live.
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Troubleshooting
“I have clocking issues which include
iD14 not locking to external ADAT or
SPDIF devices or operating at the
incorrect rate compared to my session”

Double check that an appropriate clock
source is selected (Internal for master

Troubleshooting

FAQs

“How do I reset the iD mixer application
to its default state?”

For more information and bug support,
please search our online Help Centre which

operation), ADAT or S/PDIF clock for

If there is an issue with syncing of an external

can be found here:

external slave operation. Ensure that you

To reset the mixer application, quit the

see the correct sample rate displayed in

iD app completely, then navigate to the

the Format drop-down menu.

following folder and delete the state.xml file

support.audient.com
For technical support please create

device, the Status LED in the System Panel

(it will replenish upon a fresh launch of the

will be red or yellow. If the status light is red

application)

a ticket in our online support system,

external device, and yellow if it can detect a

Macintosh HD > User > Library > Application

of our website (see link above).

signal at the wrong sample rate.

Support > Audient > iD > state.xml

To change sample rate in OSX go to Audio MIDI

(C:) > Users > yourusername > AppData >

Setup found by navigating to the folder:

Roaming > Audient > iD > state.xml

which can also be found in the support section

then iD14 cannot detect a clock signal from an

Macintosh HD > Applications > Utilities > Audio

If you are using Windows, go to the iD

Do not delete the parent folder as this will

MIDI Setup

icon in the system tray and right click on it.

also contain your iD mixer presets.

This will bring up some settings including
Ensure that Audient iD14 is seen as an audio

sample rate. Alternatively you can alter

device (Window Menu > Show Audio Window).

these settings in the Setup tab of the iD

“How do I make sure I have the latest
version of iD firmware/software?”

app.
To check for the latest updates to the
Change the sample rate to match that of

iD desktop mixer application please visit:

the external ADAT device and session.

audient.com/products/id14/downloads and download and install the latest
driver.
You will be made aware of firmware releases
from the iD app when connected to the
internet. Please refer to page 13 in
this user manual for more information
regarding firmware update.
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Technical Specifications

Dimensions
173mm

120mm

D.I / Instrument Input:

Microphone/Line Input:

RANGE: 			
LINEUP:
MAX LINEUP: 		
THD+N @ 0dBu: 		
SNR:
FREQUENCY RESPONSE - MIN GAIN

40dB
12dBu = 0dBFS
+10dBu
0.1%
100dBu A-Weighted
±0.5dB 10Hz to 20kHz

1/4” TS JACK: 		

Tip (Hot) & Sleeve (Shield)

Analogue to Digital Converter:

44.1kHz to 48.0kHz
88.2kHz to 96.0kHz
44.1kHz to 96.0kHz

1/4” TRS JACK:		

Tip (Hot), Ring (Cold) & Sleeve (Shield)

BUS POWER:
MIN REQUIREMENT:
MAX REQUIREMENT:

0.9A @ 5V
1.5A @ 5V

No. of INPUT CHANNELS:
No. of OUTPUT CHANNELS:

2
2

61.1mm

Tip (Left), Ring (Right) & Sleeve (Shield)

12dBu = 0dBFS
0.0006%
125.5dB A-Weighted
>120dB
±0.1dB 10Hz to 40kHz

62.1mm

(Measurements with 100k load)

1/4” TRS JACK::		

LINEUP:
THD+N @ -1dBFS:
DYNAMIC RANGE: 		
CROSSTALK:
FREQUENCY RESPONSE:

USB-C High Speed:

Headphone Outputs:

18.5dBu = 0dBFS
0.0009%
125.5dB A-Weighted
>116dB
±0.25dB 10Hz to 40kHz
2.59V Peak, 1.827V RMS, 223mW
4.18V Peak, 2.95V RMS, 280mW
7.72V Peak, 5.46V RMS, 100mW

Pin 2 (Hot), Pin 3 (Cold) &
Pin 1 (Shield)
Tip (Hot), Ring (Cold) &
Sleeve (Shield)

173mm

Line Outputs (DAC):

SMUX
(Stereo)

LINEUP:
THD+N @ -1dBFS:
DYNAMIC RANGE: 		
CROSSTALK:
FREQUENCY RESPONSE:
MAXIMUM LEVEL @ 30R:
MAXIMUM LEVEL @ 62R:
MAXIMUM LEVEL @ 600R:

XLR COMBI FEMALE:
1/4” TRS JACK:

0.001%
120dB A-Weighted
>80dB
±0.5dB 10Hz to 40kHz

Digital Input:
8-CHANNEL ADAT:		
4-CHANNEL ADAT:		
STEREO S/PDIF / TOSLINK:

58dB
12dBu = 0dBFS
12dBu
21dBu
2.8k
>8k
0.00170%
101dBu A-Weighted
-129dB A-Weighted
>-75dB
>-100dB
±0.5dB 10Hz to 40kHz

40mm

THD+N @ -1dBFS:
DYNAMIC RANGE:
CMRR:
FREQUENCY RESPONSE:

GAIN RANGE:		
LINEUP:			
MIC MAX INPUT LEVEL:
MAX INPUT LEVEL: 		
INPUT IMPEDANCE (Mic):
INPUT IMPEDANCE (Line):
THD+N @ 0dBu
SNR:
EIN:
		
CMRR @ 1k:
CROSSTALK:
FREQUENCY RESPONSE - MIN GAIN

>=USB 3.0 Port
USB-C: Provides higher
headphone outputs levels
(2 Analogue)
(2 Analogue)

DSP MIXER LATENCY:
ROUND TRIP (in-to-out)
			44.1kHz
0.65mS
			48.0kHz 0.6mS
			88.2kHz 0.33mS
			96.0kHz 0.31mS
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Warranty

Service

Warranty Statement

Service Information

Your iD14 comes with a manufacturer’s warranty for one year (12 months) from the

iD14 contains no user-serviceable components, please refer to qualified service personnel

date of despatch to the end user.

for diagnosis and repair. Your warranty will be void if you tamper with the device at component
level. If you have any questions with regard to the repair, please contact Audient Ltd.

The warranty covers faults due to defective materials used in manufacture and faulty
If your unit is in warranty, please contact your dealer directly for a repair or replacement (at the

workmanship only.

discretion of the dealer).
During the warranty period Audient will repair at its discretion or replace the faulty unit
provided it is returned carriage paid to an authorised Audient service centre. We will not

For out of warranty repairs, please contact Audient Ltd, after which a Return Materials

provide warranty repair if in our opinion the fault has resulted from unauthorised modification,

Authorization (RMA) number will be assigned. This number will serve as a reference for you

misuse, negligence or accident.

and helps facilitate and expedite the return process. When the unit is returned please include this
RMA number along with a description of the fault inside the packaging box.

We accept liability to repair or replace your iD14 as described above. We do not accept
any additional liability. This warranty does not affect any legal rights you may have against

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or make

the person who supplied this product - it is additional to those rights.

an enquiry, please visit: support.audient.com

Warranty Limitations
This warranty does not cover damage resulting from accident or misuse. The warranty is void
unless repairs are carried out by an authorised service centre. The warranty is void if the unit
has been modified other than at the manufacturer’s instruction. The warranty does not cover
components which have a limited life, and which are expected to be periodically replaced for
optimal performance. We do not warrant that the unit shall operate in any other way than as
described in this manual.

Audient Ltd
Aspect House
Herriard
Hampshire
RG25 2PN
United Kingdom

Tel: +44 (0) 1256 381944
audient.com
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Glossary
A		 Amperes
ADAT		

Alesis Digital Audio Tape

ADC		

Analogue to Digital Converter

DAW		

Digital Audio Workstation

ASP		

Analogue Signal Processing

CPU		

Central Processing Unit

CUE		

Artist Headphone Mix

DAC		

Digital to Analogue Converter

dB		

Decibel

dBu		

Decibel referenced to 0.775Vrms = 0 dBu

dBFS		

Decibel Full Scale

DC		

Direct Current

D.I		

Direct Injection (Instrument Input)

DoC		

Declaration of Conformity

DSP		

Digital Signal Processing

EQ		

Equaliser

FAQ		

Frequently Asked Questions

FCC		

Federal Communications Commission

GB		

Gigabyte

GUI		

Graphical User Interface

HPF		

High Pass Filter

HV		

High Voltage

i/o		

Input / Output

JFET		

Junction Field Effect Transistor

LED		

Light Emitting Diode

RoHS		

Restriction of Hazardous Substances

RAM		

Random Access Memory

S/PDIF

Sony Philips Digital Interface Format

THD+N

Total Harmonic Distortion + Noise

TRS		

Tip Ring Sleeve (1/4” Jack Balanced)

TS		

Tip Sleeve (1/4” Jack Unbalanced)

USB		

Universal Serial Bus

V		 Volts
XLR		

Extra Live Return, Extremely Low Resistance, Canon X Series, Latching,

		

Resilient Rubber Compound... or make up your own!
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